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Paper Set 1 · 17 Jun 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
A shopkeeper offers two successive discounts of 10% and 20% on a
shirt marked at ₹1,000. What is the selling price?

A.  A. ₹700

B.  B. ₹720

C.  D. ₹750

D.  C. ₹770

✓

Q2 Quant
The ratio of marks obtained by three students P, Q, R is 3 : 4 : 5. If
the difference between the highest and lowest marks is 40, find the
marks of Q.

A.  D. 60

B.  C. 80

C.  A. 85

D.  B. 90

✓

Q3 Quant
A boat can travel 20 km downstream in 2 hours and the same
distance upstream in 5 hours. Find the speed of the stream.

A.  B. 3 km/hr

B.  C. 2 km/hr

C.  D. 3.5 km/hr

D.  A. 2.5 km/hr

✓

Q4 Quant
The average speed of car during a journey should be 70 km per
hour. It covers 50% of the total distance of the journey with a speed
of 62 km per hour. What is its speed in the rest 50% distance of the
journey in km per hour? (Round your answer to the nearest integer)

A.  D. 72

B.  A. 74

C.  B. 76

D.  C. 80

✓

Q5 Quant
ମହେଶଙ୍କ ଆୟ ଚାରି  ବର୍ଷ ରେ କ୍ର ମି କ ଭାବରେ 10%, 20%, 30% ଓ 40% ବୃ ଦ୍ଧି  ପାଇଛି  ।
ଯଦି  ଚାରି  ବର୍ଷ  ପରେ ତାଙ୍କର ଆୟ ₹4,80,480 ହୁ ଏ, ତେବେ ତାଙ୍କର ପ୍ରା ରମ୍ଭି କ ଆୟର
40% (₹ ରେ) କେତେ ଥି ଲା?

A.  A. 80,000

B.  D. 1,20,000

C.  B. 1,60,000

D.  C. 60,000

✓

Q6 Quant
The ratio of the number of girls to boys in a class of 198 students is
4 : 7. If 18 boys left the class, find how many new girls would be
admitted so that the number of girls and the number of boys
becomes equal.

A.  18

B.  24

C.  30

D.  36

✓

Q7 Quant
The following data gives the total scores (out of 500 marks) of 14
students in a class.
Total Score 252 280 308 322 406

No. of students 3 4 3 3 1

Find the average score of these 14 students.

A.  C. 291

B.  A. 298

C.  B. 301

D.  D. 311

✓

Q8 Quant
Divide ₹8330 into three parts in such a way that half of the first part,
one-fourth of the second part and one-eighth of the third part are
equal. What is the value of the second part (in ₹)?

A.  C. 2380

B.  D. 2880

C.  A. 3880

D.  B. 2980
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✓

Q9 Quant
If the compound interest on a sum of ₹y at 5% per year for 2 years,
compounded annually, is ₹246, what will be the amount after 2
years?

A.  D. ₹2646

B.  A. ₹2554

C.  C. ₹2900

D.  B. ₹2246

✓

Q10 Quant
In triangle ABC, the sides have lengths AB = 7 cm, BC = 9 cm, and AC
= 14 cm. If AD is the angle bisector of angle BAC, and D lies on BC,
find the length (in cm) of BD.

A.  C. 3

B.  D. 6

C.  B. 7

D.  A. 10

✓

Q11 Quant
ଏକ ଆୟତକ୍ଷେତ୍ର ର ଦୈ ର୍ଘ୍ୟ  ଏହାର ପ୍ର ସ୍ଥର ଦୁ ଇଗୁ ଣ ଅଟେ । ଯଦି  ଦୈ ର୍ଘ୍ୟ କୁ  20 cm ର ଅଧା
ହ୍ରା ସ କରାଯାଏ ଏବଂ ପ୍ର ସ୍ଥକୁ  20 cm ର ଅଧା ବୃ ଦ୍ଧି  କରାଯାଏ, ତେବେ ଆୟତକ୍ଷେତ୍ର ର
କ୍ଷେତ୍ର ଫଳ 200 cm2 ହେବ । ଆୟତକ୍ଷେତ୍ର ର ପ୍ର ସ୍ଥ (cm ରେ) ନି ର୍ଣ୍ଣ ୟ କର ।

A.  C. 40

B.  D. 30

C.  A. 20

D.  B. 10

✓

Q12 Quant
ବାର୍ଷିକ 8% ସରଳ ସୁ ଧ ହାରରେ କେତେ ସମୟ (ମାସ)ରେ ₹3,000 ମୂ ଳଧନର ସୁ ଧ
₹380 ଟଙ୍କା ହେବ?

A.  D. 19

B.  B. 16

C.  C. 17

D.  A. 23

✓

Q13 Quant
A number when increased by 60%, gives 3930. The number is:

A.  C. 2456.25

B.  B. 2912.53

C.  D. 1228.12

D.  A. 1768.75

✓

Q14 Quant
Ashok can prepare one wooden wardrobe in 2 days and Robin can
prepare the same wardrobe in 3 days. If they work together, in how
many days will they prepare 115 wardrobes of the same kind?

A.  C. 138

B.  D. 134

C.  A. 140

D.  B. 142

✓

Q15 Quant
ଏକ ଟେଲି ଭି ଜନ ସେଟର ଚି ହ୍ନି ତ ମୂ ଲ୍ୟ ₹74,300 ଅଟେ । ଏହାକୁ  20 % ଏବଂ 30 % ର
ଦୁ ଇଟି  କ୍ର ମାଗତ ରି ହାତି  ପରେ ଜଣେ ଖୁ ଚୁ ରା ବ୍ୟବସାୟୀଙ୍କୁ  ବି କ୍ରି   କରାଯାଏ । ଖୁ ଚୁ ରା ବି କ୍ରେ ତା
ଗ୍ରା ହକଙ୍କୁ  ତାଙ୍କ ଦ୍ୱାରା ନି ର୍ଦ୍ଧା ରି ତ ମୂ ଲ୍ୟ ଉପରେ 16% ରି ହାତି  ପ୍ର ଦାନ କରି  ନି ଜର କ୍ର ୟ ମୂ ଲ୍ୟ
ଉପରେ 50% ଲାଭ ଅର୍ଜ ନ କରି ବାକୁ  ଚାହାଁ ନ୍ତି  । ତେବେ ଉକ୍ତ ଟେଲି ଭି ଜନ ସେଟର ଧାର୍ଯ୍ୟ
ମୂ ଲ୍ୟ ସେ କେତେ ସ୍ଥି ର କରି ବା ଉଚି ତ ?

A.  A. ₹74,300

B.  D. ₹74,397

C.  B. ₹74,173

D.  C. ₹74,491

✓

Q16 Quant

The roots of the equation x2 - 2x - 143 = 0 are _______.

A.  A. positive

B.  C. equal

C.  D. one positive and other negative

D.  B. negative
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✓

Q17 Quant
A ଗୋଟି ଏ କାର୍ଯ୍ୟ କୁ  6 ଦି ନରେ ଶେଷ କରି ପାରି ବେ ଯେତେବେଳେକି  B ଏହାକୁ  12 ଦି ନରେ କରି ପାରି ବେ । ଯଦି  ସେମାନେ ଏକାଠି  କାମ କରନ୍ତି  ଏବଂ କାର୍ଯ୍ୟ  ଶେଷ କରନ୍ତି , ତେବେ A ଦ୍ୱାରା
କରାଯାଇଥି ବା କାମର ଅଂଶ କେତେ?

A.  

B.  

C.  

D.  

✓

Q18 Quant

A.  B. 57

B.  C. 54

C.  A. 53

D.  D. 52

✓

Q19 Quant
Simplify: 72 − {(-17) × [(-7 − 5 − 7)]} ÷ [2 × {9 + (-1) × (-2)}]

A.  

B.  

C.  

D.  

✓

Q20 Quant
The perimeter of a square is 36 cm. What is the length (in cm) of its diagonal?2207

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
Which of the following universities won Maulana Abul Kalam Azad
(MAKA) Trophy 2024?

A.  A. Guru Nanak Dev University, Amritsar

B.  B. Lovely Professional University

C.  C. Chandigarh University

D.  D. Delhi University

✓

Q22 GA
In June 2025, which of the following operations was launched by the
Government of India to evacuate Indian nationals from conflict
zones in Iran and Israel?

A.  A. Operation Shiva

B.  B. Operation Sindoor

C.  D. Operation Sukoon

D.  C. Operation Sindhu

✓

Q23 GA
Which of the following is the operation launched by the Indian Army
in 2025 for Amarnath Yatra security of pilgrims?

A.  D. Operation Shiva

B.  B. Operation Sindoor

C.  C. Operation Sukoon

D.  A. Operation Devi Shakti

✓

Q24 GA
The Odisha government in 2022 has designated Mahendragiri hill in
Gajapati district as a ______.

A.  D. Tiger Reserve

B.  C. Biosphere Reserve

C.  B. Biodiversity Heritage Site

D.  A. Ramsar Site

✓

Q25 GA
Which of the following is the deepest oceanic trench in the world?

A.  D. Mariana Trench

B.  A. Tonga Trench

C.  B. Philippine Trench

D.  C. Kuril–Kamchatka Trench

✓

Q26 GA
ପୁ ରୀସ୍ଥି ତ ଶ୍ରୀ ଜଗନ୍ନାଥଙ୍କ ମନ୍ଦି ର ପରମ୍ପରାରେ ଗଭୀର ଭାବେ ଜଡି ତ ଏବଂ ସଙ୍ଗୀତ ନାଟକ
ଏକାଡେମୀ ଦ୍ୱାରା ଭାରତର ଏକ ପ୍ର ମୁ ଖ ଶାସ୍ତ୍ରୀୟ ନୃ ତ୍ୟ ଭାବେ ସ୍ୱୀକୃ ତି ପ୍ରା ପ୍ତ କେଉଁ  ଶାସ୍ତ୍ରୀୟ
ନୃ ତ୍ୟ ଶୈ ଳୀ ଓଡ଼ି ଶାର ସାଂସ୍କୃତି କ ଇତି ହାସର ଏକ ମହତ୍ତ୍ୱପୂ ର୍ଣ୍ଣ  ଦି ଗକୁ  ଉପସ୍ଥାପନ କରି ଥାଏ?

A.  D. ଭାରତନାଟ୍ୟମ

B.  C. କଥକ

C.  A. ଓଡ଼ି ଶୀ

D.  B. କୁ ଚି ପୁ ଡି

✓

Q27 GA
ଗୋଟି ଏ ବଡ଼ ହଲ୍ ‌ରେ କାନ୍ଥରୁ  ବାରମ୍ବାର ପ୍ର ତି ଫଳନ ଯୋଗୁଁ  ଧ୍ୱନି ର ସ୍ଥି ରତାକୁ  __________
କୁ ହାଯାଏ ।

A.  D. ପ୍ର ତି ଧ୍ୱନି

B.  B. ପ୍ର ତି ନାଦ

C.  C. କମ୍ପନ

D.  A. ବି କୀର୍ଣ୍ଣ ନ

✓

Q28 GA
Which highway was reported to be submerged due to flooding in
Odisha’s Koraput–Malkangiri region in August 2025?

A.  C. NH 326

B.  A. NH 249

C.  B. NH 116

D.  D. NH 203

✓

Q29 GA
Two Odisha teachers (Basanta K. Rana, Tarun K. Dash) received
National Teachers’ Awards 2025. They serve in which districts?

A.  D. Malkangiri & Koraput

B.  C. Ganjam & Nayagarh

C.  B. Khordha & Puri

D.  A. Cuttack & Kandhamal

✓

Q30 GA
The cytoplasm is the cell’s _____ within the plasma membrane
containing specialized _____ for functions.

A.  C. fluid; organelles​

B.  A. sap; ribose​

C.  D. matrix; genes​

D.  B. wall; pores​
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✓

Q31 GA
Which of the following judges presided over Mahatma Gandhi’s
sedition trial in 1922?

A.  A. Lord Reading

B.  C. Sir John Stanley

C.  B. Justice Ranade

D.  D. Justice C.N. Broomfield

✓

Q32 GA
Lionel Messi won the 2025 MLS Golden Boot while playing for which
club?

A.  A. Inter Miami CF

B.  C. LA Galaxy

C.  D. New York City FC

D.  B. Atlanta United

✓

Q33 GA
The Godavari River is often referred to as the “Dakshin Ganga” in
Indian geography. Which of the following best explains this
designation?

A.  D. It originates from the Himalayan mountain system

B.  A. It is the longest river in the Indian subcontinent

C.  C. It has an extensive course and the largest drainage basin
in Peninsular India

D.  B. It flows westward similar to the Narmada River

✓

Q34 GA
Which Article of the Indian Constitution deals with the power of the
Parliament to amend the Constitution and its procedure?

A.  A. Article 356

B.  D. Article 370

C.  C. Article 352

D.  B. Article 368

✓

Q35 GA
Which of the following is India’s largest multi-sport event at the
national level, organized by the Indian Olympic Association?

A.  D. Khelo India Youth Games

B.  B. National Games of India

C.  A. All India University Games

D.  C. School Games Federation of India Games

✓

Q36 GA
ବି ପର୍ଯ୍ୟ ୟ ପରି ଚାଳନାର କେଉଁ  ପର୍ଯ୍ୟା ୟଟି  ବି ପର୍ଯ୍ୟ ୟର ପ୍ର ଭାବକୁ  ହ୍ରା ସ କରି ବା ପାଇଁ  ଏହାର
ପୂ ର୍ବ ରୁ  ନି ଆଯାଇଥି ବା ପଦକ୍ଷେପ ଉପରେ ଗୁ ରୁ ତ୍ୱ ଦେଇଥାଏ?

A.  A. ରି ଲି ଫ ପର୍ଯ୍ୟା ୟ

B.  B. ପୁ ନରୁ ଦ୍ଧାର ପର୍ଯ୍ୟା ୟ (Recovery stage)

C.  D. ପ୍ର ଶମନ ପର୍ଯ୍ୟା ୟ (Mitigation stage)

D.  C. କ୍ଷୟକ୍ଷତି  ଆକଳନ ପର୍ଯ୍ୟା ୟ 

✓

Q37 GA
ଡେରୋଜି ଓ (Derozio)ଙ୍କ କେଉଁ  କୃ ତି ରେ ସେ ଜଣେ ଯୁ ବ ହି ନ୍ଦୁ  ବି ଧବାଙ୍କ ଦୁ ର୍ଦ୍ଦ ଶାକୁ
କୌଶଳର ସହ ବର୍ଣ୍ଣ ନା କରି , ନି ଜର ବର୍ଣ୍ଣ ନାତ୍ମକ ଏବଂ ବୈ ଷୟି କ ଦକ୍ଷତା ପ୍ର ଦର୍ଶ ନ କରି ଛନ୍ତି ?

A.  A. ଦୀର୍ଘ  କବି ତା: ଦି  ଫକୀର ଅଫ ଜଙ୍ଗୀରା (The Fakeer of Jungheera)

B.  B. ତାଙ୍କ ସାମ୍ବାଦି କତା କ୍ୟାରି ୟର ସମୟରେ ଲେଖାଯାଇଥି ବା ପ୍ର ବନ୍ଧଗୁ ଡ଼ି କ 

C.  C. ସନେଟ: ଦ ହାର୍ପ  ଅଫ ଇଣ୍ଡି ଆ (The Harp of India)

D.  D. ତାଙ୍କର ଛୋଟ ଗୀତି  କବି ତାର ସଂଗ୍ର ହ 

✓

Q38 GA
Why is bleaching powder used in the textile industry?

A.  B. To add fragrance to fabrics

B.  A. To increase the softness of cloth

C.  D. To remove colour and stains from fabric

D.  C. To disinfect the fabric

✓

Q39 GA
Which of the following is NOT one among the dimensions
considered in calculating the Human Development Index (HDI)?

A.  D. Life expectancy at birth

B.  A. Gross national income per capita

C.  C. Employment rate

D.  B. Mean years of schooling for adults

✓

Q40 GA
ଇଣ୍ଡି ଆ ଉଡ ସେକ୍ଟର ରି ପୋର୍ଟ , 2021 ଅନୁ ଯାୟୀ, ଭାରତର କ୍ରା ନ୍ତୀୟ ଚି ରହରି ତ ଅରଣ୍ୟରେ
ମି ଳୁ ଥି ବା ନି ମ୍ନ ଲି ଖି ତ ବୃ କ୍ଷ ମଧ୍ୟରୁ  କେଉଁ ଟି  ନି ଷି ଦ୍ଧ (banned) ଅଟେ?

A.  B. ରୋଜଉଡ (Rosewood)

B.  A. ହଲମଦ୍ଦି  (Halmaddi)

C.  D. ଚନ୍ଦନ କାଠ (Sandalwood)

D.  C. ଇବୋନି  (Ebony)

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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English

✓

Q41 English
Select the most appropriate ANTONYM of the underlined word in the given sentence.

She was resilient in pursuing her objective in spite of the constant criticism she received.

A.  B. Fragile

B.  A. Courageous

C.  D. Centred

D.  C. Composed

✓

Q42 English
Which sentence uses the correct form of the past tense?

A.  C. Manish speak very well during the debate.

B.  B. Manish spoken very well during the debate.

C.  D. Manish spoke very well during the debate.

D.  A. Manish speaking very well during the debate.

✓

Q43 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

P= A broader shift toward more controlled and secure travel policies
Q= While citizens of these nations will still be able to visit Brazil
R= For up to 90 days for business
S= And student purposes without a visa, the change represents

A.  B. QRSP

B.  D. SQRP

C.  A. PRQS

D.  C. RQSP

✓

Q44 English
Convert the following sentence from Active to Passive Voice.

The teacher is explaining the lesson to the students.

A.  A. The lesson is explained the students by the teacher.

B.  B. The lesson is being explained to the students by the teacher.

C.  C. The lesson was explained to the students by the teacher.

D.  D. The lesson will be explained to the students by the teacher.
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✓

Q45 English
Choose the option that correctly replaces the underlined idiom in the sentence below.

The advocate decided to let the cat out of the bag during the final hearing.

A.  D. hide the main argument

B.  B. reveal the hidden secret

C.  A. withdraw from the hearing

D.  C. confuse the opposing lawyer

✓

Q46 English
Select the correct antonym for the underlined word from the options.
The driver pressed the pedal to accelerate quickly and merge safely onto the highway.

A.  B. decrease

B.  D. exhilarate

C.  A. exaggerate

D.  C. accomplish

✓

Q47 English
Identify the misspelt word in the given sentence and rectify the error by choosing the correct option.

Researchers studied the migratory patterns of whales to analize changes in ocean currents caused by climate shifts.

A.  B. reserchers

B.  C. migretory

C.  A. analyze

D.  D. curents

✓

Q48 English
Select the correct meaning of the idiom that can replace the underlined words.

After missing the final shot, the captain was advised not to dwell on it and focus on the next match.

A.  D. think continuously about it

B.  B. blame others for it

C.  C. discuss it publicly

D.  A. deny responsibility for it

✓

Q49 English
Complete the reported speech form of the following sentence correctly.

Sentence: "Did you finish the report last night?" the manager asked me.
The manager asked me ______

A.  B. if I finished the report the previous night.

B.  D. if I had finished the report the previous night.

C.  C. did I finish the report last night?

D.  A. whether I finished the report last night.
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✓

Q50 English
Complete the sentence by selecting the appropriate option.
The athlete trained ______ for the competition and performed ______ during the final match, securing a decisive victory.

A.  D. irregularly, poorly

B.  C. diligently, exceptionally

C.  B. casually, inadequately

D.  A. reluctantly, barely

✓

Q51 English

Read the passage and answer the questions that follow:
Trees play an essential role in maintaining ecological balance and supporting life on Earth. They absorb carbon dioxide and release oxygen,
making the air breathable for living organisms. In addition to improving air quality, trees help regulate temperature by providing shade and
reducing the impact of heat. Their roots bind the soil together, preventing erosion and maintaining soil fertility. Furthermore, trees serve as
habitats for numerous species of birds, insects, and animals, thereby supporting biodiversity. They also contribute to the water cycle by
facilitating rainfall and maintaining groundwater levels. Despite their importance, deforestation continues to threaten ecosystems across the
globe. Human activities such as urban expansion and industrial development often lead to the large-scale removal of trees. Protecting and
planting trees is therefore crucial for sustaining environmental health. Awareness and collective action can ensure that future generations inherit
a greener and more balanced planet.

Identify a suitable title for the passage:

A.  D. The Importance of Trees in Maintaining Environmental Balance

B.  C. The Effects of Industrial Growth on Natural Landscapes

C.  A. The Role of Animals in Supporting Ecosystem Stability

D.  B. The Development of Urban Areas in Modern Society

✓

Q52 English
Identify the facts given in the passage:

A.  B. Trees grow only in specific climates and limited regions

B.  C. Trees do not influence rainfall or water cycle processes

C.  D. Trees are mainly useful for decorative urban purposes

D.  A. Trees absorb carbon dioxide and release oxygen into the air

✓

Q53 English
Identify the tone of the passage:

A.  D. Critical and dismissive

B.  A. Informative and concerned

C.  B. Humorous and entertaining

D.  C. Indifferent and neutral
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✓

Q54 English
Identify the structure of the passage:

A.  A. Problem introduced followed by causes, effects, and solution

B.  C. Chronological sequence of historical environmental events

C.  B. Dialogue between experts discussing scientific theories

D.  D. Narrative story focusing on fictional environmental changes

✓

Q55 English
Select the correct summary for the passage:

A.  C. Trees are only important for providing shade in urban areas

B.  B. Trees mainly help animals and do not affect human life

C.  D. Trees support environment, face threats, and need protection

D.  A. Trees are gradually becoming less important in modern times

✓

Q56 English
Choose the correct option to complete the sentence.

The author is well known ______ his contributions to modern literature.

A.  B. for

B.  D. with

C.  C. at

D.  A. in

✓

Q57 English
Select the most appropriate option that can replace the underlined segment in the given sentence.

He was declared an (a) enemy of the country and exiled.

A.  C. traitor

B.  B. patriot

C.  D. anarchist

D.  A. adversary

✓

Q58 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

P. that he is meeting with
Q. who has been searching for a job for a few months
R. and is getting disappointed by the failures
S. it seems that he is an unemployed youngster

A.  A. SQRP

B.  C. SPRQ

C.  D. RQSP

D.  B. RSPQ
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✓

Q59 English
Select the option that can be used as a one-word substitute for the given group of words.

The study of the origin and development of societies

A.  B. Psychology

B.  C. Sociology

C.  D. Anthropology

D.  A. Archaeology

✓

Q60 English
Select the most appropriate option to fill in the blank.

She adopted ___ cat from the animal shelter yesterday.

A.  A. a

B.  D. an

C.  C. the

D.  B. that

Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ଚାନ୍ଦି ନୀ ରାସ୍ତାରେ ____ ପଡି ଗଲା ।''

A.  A. ଧୀରେ ଧୀରେ

B.  C. ଚାଲୁ ଚାଲୁ

C.  B. ହସି  ହସି

D.  D. ବାରମ୍ବାର

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ସମାନାର୍ଥ ବୋଧକ ଶବ୍ଦ ଲେଖ।
ଆଜି  ମୁଁ  ଏକ "ନୂ ତନ" ବହି  କି ଣି ଲି ।

A.  B. ପୁ ରୁ ଣା

B.  D. ଅଧୁ ନି କ

C.  A. ଦୀର୍ଘ

D.  C. ଅନନ୍ତ

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Ashoka was a great emperor of the Maurya dynasty.

A.  C. ଅଶୋକ ମୌର୍ଯ୍ୟ  ସାମ୍ରା ଜ୍ୟର ଏକ ମହାନ ସମ୍ରା ଟ ଥି ଲେ।

B.  A. ଆଶୋକ ମୌର୍ଯ୍ୟ  ବଂଶର ଏକ ମହାନ ସମ୍ରା ଟ୍  ଅଟନ୍ତି ।

C.  D. ଆଶୋକ ମୌର୍ଯ୍ୟ  ବଂଶର ଏକ ମହାନ ସମ୍ରା ଟ୍  ଅଛନ୍ତି ।

D.  B. ଆଶୋକ ମୌର୍ଯ୍ୟ  ବଂଶର ଏକ ମହାନ ସମ୍ରା ଟ୍  ହେଉଛନ୍ତି ।
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✓

Q64 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The literacy rate in India has improved in recent years.

A.  D. ଭାରତର ସାକ୍ଷରତା ହାର ନି କଟ ବର୍ଷ ରେ ଉନ୍ନତ ହୋଇଛି ।

B.  C. ଭାରତର ସାକ୍ଷରତା ହାର ଶେଷ ବର୍ଷ  ଉନ୍ନତ ହୋଇଛି ।

C.  A. ଭାରତର ସାକ୍ଷରତା ହାର ଶେଷ ବର୍ଷ  ଭଲ ହୋଇଛି ।

D.  B. ଭାରତ ସାକ୍ଷରତା ହାର ଶେଷ କି ଛି  ବର୍ଷ  ଭଲ ଅଛି ।

✓

Q65 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The national flag of India has three horizontal stripes of different colors.

A.  C. ଭାରତର ଜାତୀୟ ପତାକାରେ ଭି ନ୍ନ ରଙ୍ଗର ତି ନୋଟି  ସମସ୍ତରୀୟ ପଟ୍ଟୀ ରହି ଛି ।

B.  B. ଭାରତର ଜାତୀୟ ପତାକା ତି ନୋଟି  ଭି ନ୍ନ ରଙ୍ଗ ଅନୁ ଲମ୍ବ ପଟି  ଅଛନ୍ତି ।

C.  A. ଭାରତ ଜାତୀୟ ପତାକାରେ ତି ନୋଟି  ଭି ନ୍ନ ରଙ୍ଗ ଅଛି ।

D.  D. ଭାରତର ଜାତୀୟ ପତାକା ତି ନୋଟି  ରଙ୍ଗ ଅନୁ ଲମ୍ବ ପଟି  ହେଉଛି ।

✓

Q66 Odia
ସଠି କ ତତ୍ସମ ଶବ୍ଦ ବାଛନ୍ତୁ: “ଆଖି ” ର ତତ୍ସମ କଣ?

A.  D. ନୟନ

B.  C. ଦୃ ଷ୍ଟି

C.  B. ଚକ୍ଷୁ

D.  A. ଦେଖା

✓

Q67 Odia
ଉପଯୁ କ୍ତ ବି ଶେଷଣ ଦ୍ଵାରା ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର ।
କ୍ର ମେ କ୍ର ମେ ତାଙ୍କ ଶରୀର _ହୋଇପଡୁ ଛି  ।

A.  D. ଶକ୍ତି ଶାଳୀ

B.  A. ଦୁ ର୍ବ ଳ

C.  C. ସୁ ନ୍ଦର

D.  B. ମନୋହର

✓

Q68 Odia
କେଉଁ ଟି  ତଦ୍ଭବ ଶବ୍ଦ ଚି ହ୍ନଟ କର ?

A.  A. ଜଗତ

B.  B. ଝଙ୍କାର

C.  D. ମି ଠା

D.  C. ପର୍ବ
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✓

Q69 Odia

ନି ମ୍ନୋ କ୍ତ ଅନୁ ଚ୍ଛେଦକୁ  ପଢି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ଚୟନ କର ।
ମହର୍ଷି ଭରଦ୍ଵାଜଙ୍କ ପୁ ତ୍ର  ଥି ଲେ ଦ୍ରୋ ଣ। କୃ ପାଚାର୍ଯ୍ୟ ଙ୍କ ଭଗ୍ନୀ କୃ ପୀଙ୍କୁ  ବି ବାହ କରି ଥି ଲେ। ପରବର୍ତ୍ତୀ  ସମୟରେ କୌରବ ଶତଭ୍ରା ତା ତଥା ପାଣ୍ଡବଙ୍କର ଶସ୍ତ୍ର ଗୁ ରୁ  ଭାବେ ମାନ୍ୟତା ପାଇଥି ଲେ। ଜଣେ
ଶସ୍ତ୍ର ଗୁ ରୁ  ଭାବରେ ଖ୍ୟାତି ଲାଭ କରି ବା ପଛରେ ଏକ ରୋଚକ ତଥ୍ୟ ଅଛି । ଦ୍ରୋ ଣଙ୍କର ବି ଶେଷତ୍ଵ ଥି ଲା ପରଶୁ ରାମଙ୍କ ଶି ଷ୍ୟ ଭାବରେ। ପରଶୁ ରାମ ଥି ଲେ ଅଜେୟ ଯୋଦ୍ଧା ଯି ଏ କି  ଥରେ ଦୁ ଇଥର
ନୁ ହେଁ , ହେଁ , ଏକୋଇଶ ବାର ପୃ ଥି ବୀ ନି କ୍ଷତ୍ରି  ୟ କରି ଥି ଲେ ନି ଜ କଠୋର ପ୍ର ତି ଜ୍ଞା ପୂ ରଣ ନି ମନ୍ତେ। ଆର୍ଥିକ ଅବସ୍ଥା ସ୍ଵଚ୍ଛଳ ନଥି ଲା। ଉତ୍କଟ ଦାରି ଦ୍ର୍ୟ  ସହ ଯୁ ଝୁ ଥି ଲେ। ଏଇ ସମୟରେ ଶୁ ଣି ବାକୁ  ପାଇଲେ
ପ୍ର ୟାଗ ତୀର୍ଥ ରେ ଜମଦଗ୍ନି  ଋଷି ଙ୍କ ପୁ ଅ ପରଶୁ ରାମ ନି ଜର ଯାହାକି ଛି  ଧନସମ୍ପତ୍ତି  ଅଛି  ସେ ସବୁ କୁ  ଦାନ କରି ବାରେ ଲାଗି ଛନ୍ତି । ମନକୁ  ଆସି ଲା ପରଶୁ ରାମଙ୍କ କୃ ପା କଣି କା ଲାଭ କଲେ ଦାରି ଦ୍ର୍ୟ  ଦୂ ର
ହୋଇଯି ବ ନି ଶ୍ଚୟ। ଅନେକ ଆଶା ନେଇ ପରଶୁ ରାମଙ୍କ ନି କଟକୁ  ଯାଇଥି ଲେ। ହେଲେ ଧନଲାଭର ଯେଉଁ  ବଡ଼ ଆଶା ନେଇ ସେ ଯାଇଥି ଲେ, ତାଙ୍କୁ  ନି ରାଶ ହେବାକୁ  ପଡ଼ି ଥି ଲା। ସେତେବେଳକୁ  ବହୁ ତ
ବି ଳମ୍ବ ହୋଇଯାଇଥି ଲା। ପରଶୁ ରାମ ତାଙ୍କର ସମ୍ପଦ ଦାନ କରି  ସାରି ଥାନ୍ତି  । ପରଶୁ ରାମ ଦି ବ୍ୟଦୃ ଷ୍ଟି  ବଳରେ ଜାଣି  ପାରି ଥି ଲେ, ଦ୍ରୋ ଣ ଜଣେ ମହା ତେଜସ୍ୱୀ ବ୍ରା ହ୍ମଣ ବୋଲି  । ଜଣେ ତେଜସ୍ୱୀ ବ୍ରା ହ୍ମଣ
ତାଙ୍କ ନି କଟକୁ  କି ଛି  ପ୍ରା ପ୍ତି  ଆଶାରେ ଆସି  ନି ରାଶ ହୋଇ ଫେରି  ଯି ବାକୁ  ଉଚି ତ ମଣି  ନଥି ଲେ । ତାଙ୍କ ପରି ଚୟ ପଚାରି ବାରୁ  ଜାଣି ବାକୁ  ପାଇଥି ଲେ ସେ ହେଉଛନ୍ତି  ମହର୍ଷି ଭରଦ୍ଵାଜଙ୍କ ତନୟ ।
ତାଙ୍କଠାରେ ଯେଉଁ  ପ୍ର ତି ଭା ଲୁ କ୍ ‌କାୟି ତ ଭାବରେ ରହି ଛି  ତାହା କ‌ଥାବାର୍ତ୍ତା ରୁ  ଠଉରାଇ ନେଇଥି ଲେ ପରଶୁ ରାମ। ଧନସମ୍ପଦ ସି ନା ଦେଇପାରି  ନ ଥି ଲେ, ହେଲେ ପାଖରେ ରଖି  ଅସ୍ତ୍ରବି ଦ୍ୟା ଶି କ୍ଷା
ଦେଇଥି ଲେ। ଅସ୍ତ୍ର ବି ଦ୍ୟାରେ ତାଙ୍କୁ  ଜଣେ ପାରଙ୍ଗମ, ଦୁ ର୍ଜ ୟ ଯୋଦ୍ଧା ଭାବରେ ପରି ଗଣି ତ କରାଇବାର ଦାୟି ତ୍ୱ ନେଇଥି ଲେ ପରଶୁ ରାମ । ଗୁ ରୁ ଙ୍କ ଉପଯୁ କ୍ତ ଦି ଗ୍ ‌ଦର୍ଶ ନରେ ଦ୍ରୋ ଣାଚାର୍ଯ୍ୟ  ଅସ୍ତ୍ରବି ଦ୍ୟା
ଶି କ୍ଷାସହ ରଣକୌଶଳ ଶି ଖି  ଅଳ୍ପଦି ନ ବ୍ୟବଧାନରେ ଜଣେ ପ୍ର ବୀଣ ଅସ୍ତ୍ର ବି ଶାରଦ ହୋଇଗଲେ । ପରଶୁ ରାମଙ୍କଠାରୁ  ଯୁ ଦ୍ଧବି ଦ୍ୟା ଶି କ୍ଷା ହିଁ ତାଙ୍କୁ  ଜଣେ ଅସାଧାରଣ ଯୋଦ୍ଧାର ମାନ୍ୟତା ଦେଇଥି ଲା।
ଆହରି ତ ଜ୍ଞାନ ବଳରେ କୂ ପମଧ୍ୟରୁ  କୌରବ-ପାଣ୍ଡବ ଖେଳୁ ଥି ବା କନ୍ଦୁ କ ଉଦ୍ଧାର କରି  ପି ତାମହ ଭୀଷ୍ମ  କର୍ତ୍ତୃ କ ନି ଯୁ କ୍ତି  ପାଇଥି ଲେ କୌରବ-ପାଣ୍ଡବ ଭ୍ରା ତାଙ୍କ ଶସ୍ତ୍ର ଗୁ ରୁ  ଭାବରେ। ଏହି  ନି ଯୁ କ୍ତି  ହିଁ ତାଙ୍କ
ଜୀବନରେ ଆଣି ଥି ଲା ଅଭୂ ତପୂ ର୍ବ  ପରି ବର୍ତ୍ତ ନ।

ଉପରୋକ୍ତ ଅନୁ ଚ୍ଛେଦର ସ୍ଵର ଚି ହ୍ନଟ କର ?

A.  A. ହାସ୍ୟମୟ

B.  D. ପ୍ରେ ରଣାଦାୟକ ଓ ଜ୍ଞାନମୂ ଳକ

C.  B. ତ୍ୟାଗ

D.  C. ବ୍ୟଙ୍ଗାତ୍ମକ

✓

Q70 Odia
‘ସ୍ଵଚ୍ଛଳ’ ଶବ୍ଦର ଅର୍ଥ  କ'ଣ?

A.  C. ଦରି ଦ୍ର

B.  A. ସମୃ ଦ୍ଧ ଓ ସୁ ବି ଧାସମ୍ପନ୍ନ

C.  B. ଅଶାନ୍ତ

D.  D. ଅଳ୍ପ

✓

Q71 Odia
ଏହି  ଗଦ୍ୟାଂଶର ଗଢଣ ଚି ହ୍ନଟ କର ?

A.  D. କାଳ୍ପନି କ

B.  A. ଐତି ହାସି କ

C.  C. ପୌରାଣି କ

D.  B. ସାମାଜି କ

✓

Q72 Odia
ଅନୁ ଛେଦର ତଥ୍ୟଟି  ଚି ହ୍ନଟ କର ?

A.  B. ଦ୍ରୋ ଣ ଧନୀ ପରି ବାରରେ ଜନ୍ମ  ନେଇଥି ଲେ

B.  A. ପରଶୁ ରାମ ତାଙ୍କୁ  ଧନସମ୍ପଦ ଦେଇଥି ଲେ

C.  C. ପରଶୁ ରାମ ଦ୍ରୋ ଣଙ୍କୁ  ଅସ୍ତ୍ରବି ଦ୍ୟା ଶି ଖାଇଥି ଲେ

D.  D. ଦ୍ରୋ ଣ ଯୁ ଦ୍ଧକୁ  ଭୟ କରୁ ଥି ଲେ
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✓

Q73 Odia
ଅନୁ ଚ୍ଛେଦରେ ଦି ଆଯାଇଥି ବା “ଉପଯୁ କ୍ତ” ର ବି ପରୀତ ଶବ୍ଦଟି  ଚୟନ କର ।

A.  B. ଅପକାର

B.  C. ଅବସାନ

C.  A. ଅନୁ ପଯୁ କ୍ତ

D.  D. ଅନୁ ପଗତ

✓

Q74 Odia
"ପବନ ଧୀରେ ବହୁ ଛି " ଏହି  ବାକ୍ୟରେ କ୍ରି  ୟା ବି ଶେଷଣ ପଦଟି  କି ଏ?

A.  A. ପବନ

B.  C. ଧୀରେ

C.  D. ବହୁ ଛି

D.  B. କୌଣସି ଟି  ନୁ ହେଁ

✓

Q75 Odia
'ବି ରାଡ଼ି  କପାଳକୁ  ଶି କା ଛି ଣ୍ଡି ବା' ଏହି  ରୂ ଢି ର ଅର୍ଥ  କଣ?

A.  D. ବି ରାଡ଼ି  ଶି କା ଛି ଣ୍ଡାଇବା

B.  A. ଅପେକ୍ଷା କରି ବା

C.  C. ହଠାତ୍  ଅପ୍ର ତ୍ୟାଶି ତ ସୁ ବି ଧା ମି ଳି ବା

D.  B. ଦୁ ର୍ଭା ଗ୍ୟ ଆସି ବା
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Computer

✓

Q76 Computer
Which of the following is considered application software in
Windows 11?

A.  B. BIOS

B.  C. Microsoft Word

C.  A. Windows 11

D.  D. Device Driver

✓

Q77 Computer
ଜଣେ ଡକ୍ୟୁ ମେଣ୍ଟ ଏଡି ଟର ଏଭଳି  ଏକ ଇଫେକ୍ଟ ହାସଲ କରି ବାକୁ  ଚାହାଁ ନ୍ତି  ଯେଉଁ ଥି ରେ
ପ୍ର ତ୍ୟେକ ପାରାଗ୍ରା ଫର ପ୍ର ଥମ ଲାଇନ ଅନ୍ୟାନ୍ୟ ଲାଇନଗୁ ଡ଼ି କ ଠାରୁ  ଅଧି କ ଇଣ୍ଡେଣ୍ଟ
(indented) ହୋଇଥି ବ, କି ନ୍ତୁ ସେ ପୁ ରା ପାରାଗ୍ରା ଫକୁ  ଲେଫ୍ଟ  ମାର୍ଜିନ ଠାରୁ  1-ଇଞ୍ଚ ଦୂ ରତା
ବଜାୟ ରଖି ବା ମଧ୍ୟ ଆବଶ୍ୟକ ମଣନ୍ତି  । ଏହି  ସଠି କ ଫର୍ମା ଟିଂ  ହାସଲ କରି ବା ପାଇଁ
Paragraph Dialog Box ମଧ୍ୟରେ କେଉଁ  ଦୁ ଇଟି  ନି ର୍ଦ୍ଦିଷ୍ଟ ସେଟିଂ ସକୁ  କନଫି ଗର
(configure) କରି ବାକୁ  ହେବ?

A.  D. Alignment କୁ  "Justified" ସେଟ କରି ବାକୁ  ହେବ ଏବଂ Spacing କୁ
"Single" ସେଟ କରି ବାକୁ  ହେବ

B.  B. Indentation (Left) କୁ  "1 inch" ସେଟ କରି ବାକୁ  ହେବ ଏବଂ Special କୁ
"Hanging" ସେଟ କରି ବାକୁ  ହେବ

C.  C. Indentation (Left) କୁ  "1 inch" ସେଟ କରି ବାକୁ  ହେବ ଏବଂ Special କୁ
"First line" ସେଟ କରି ବାକୁ  ହେବ

D.  A. Spacing (Before) କୁ  "12 pt" ସେଟ କରି ବାକୁ  ହେବ ଏବଂ Special କୁ
"First line" ସେଟ କରି ବାକୁ  ହେବ

✓

Q78 Computer
To make an audio file play automatically when a slide appears in
PowerPoint, which of the following should one choose under Audio
Options?

A.  A. In Click Sequence

B.  C. When Clicked

C.  D. Automatically

D.  B. Play in Background

✓

Q79 Computer
କେଉଁ  ମେନୁ  ୟୁ ଜରମାନଙ୍କୁ  ସ୍ଲା ଇଡ ଶୋ କି ପରି  ଚାଲି ବ ତାହା ସେଟ ଅପ କରି ବାକୁ  ଅନୁ ମତି
ଦି ଏ?

A.  B. Home → Setup

B.  D. Slide Show → Set Up Slide Show

C.  A. Insert → Slide Show Setup

D.  C. View → Slide Show Setup

✓

Q80 Computer
In MS-Excel, text is by default aligned:

A.  B. Left

B.  A. Right

C.  D. Center

D.  C. Justify

✓

Q81 Computer
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ସେବା ୟୁ ଜରମାନଙ୍କ ମଧ୍ୟରେ ରି ଅଲ-ଟାଇମ ଟେକ୍ସଟ-ଆଧାରି ତ
କମ୍ୟୁ ନି କେଶନକୁ  ଅନୁ ମତି  ଦି ଏ?

A.  A. FTP

B.  B. ଚାଟିଂ  କି ମ୍ବା ଇନଷ୍ଟାଣ୍ଟ ମେସେଜି ଙ୍ଗ

C.  C. ଟେଲନେଟ

D.  D. ନି ଉଜଗୃ ପ

✓

Q82 Computer
Which Internet service protocol is primarily used for transferring
files between computers over a network?

A.  B. SMTP

B.  C. FTP

C.  A. IMAP

D.  D. POP3

✓

Q83 Computer
ASCII is used in computers for which major purpose?

A.  B. To store audio files

B.  D. To represent characters using numeric codes

C.  C. To increase network speed

D.  A. To format Compact Disks

✓

Q84 Computer
Which of the following is the best example of Application Software?

A.  A. Windows 11 Operating System

B.  D. Microsoft Word 2021

C.  C. Device Driver for a printer

D.  B. BIOS (Basic Input/Output System)
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✓

Q85 Computer
What is the use of placing a dollar sign ($) before column and/or row
in a formula in MS Excel 2021 ?

A.  D. To create absolute references that don’t shift when copied

B.  B. For currency format

C.  C. To color cells

D.  A. To enable macros

✓

Q86 Computer
Bullets and numbering in MS Word documents are used to:

A.  D. change font size

B.  A. create organized lists

C.  B. insert images

D.  C. change page orientation

✓

Q87 Computer
ପେଜ ଫର୍ମା ଟି ଙ୍ଗ (Page formatting) ରେ __________ ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ  ।

A.  B. ମାର୍ଜିନ ଆଣ୍ଡ ପେଜ ଓରି ଏଣ୍ଟେସନ

B.  D. ହେଡର ଆଣ୍ଡ ଫୁ ଟର

C.  C. ପେଜ ନମ୍ବର

D.  A. ଟେବୁ ଲ ଅଫ କଣ୍ଟେଣ୍ଟସ

✓

Q88 Computer
Which of the following CD/DVD has a capacity of 25 GB, and allows
for higher quality video and audio with higher resolution?

A.  A. CD-ROM

B.  D. CD-R

C.  B. DVD

D.  C. Blu-ray

✓

Q89 Computer
Which option must you select in order to fit the spreadsheet on one
page?

A.  C. Page Layout → Scale to Fit

B.  D. Page Layout → Margins

C.  B. Page Layout → Orientation

D.  A. Page Layout → Print Area

✓

Q90 Computer
Which keyboard shortcut starts the slideshow from the current slide
in PowerPoint 2024?

A.  C. F5

B.  A. Shift + F5

C.  D. Alt + F5

D.  B. Ctrl + Enter
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Reasoning

✓

Q91 Reasoning
In a certain code language,
'A + B' means ‘A is the wife of B’,
'A – B' means ‘A is the brother of B’,
'A x B' means ‘A is the mother of B’,
'A = B' means ‘A is the father of B’.

How is P related to Q if ‘P x R – Y + S = Q’?1955

A.  D. Mother's mother

B.  C. Father's sister

C.  B. Wife's father's mother

D.  A. Wife's mother's sister's daughter

✓

Q92 Reasoning
What should come in place of the '?' in the given series based on the
English alphabetical order to make it logically complete?

PUY OTX NSW MRV ?

A.  A. LQU

B.  B. LQV

C.  C. LRU

D.  D. LRV

✓

Q93 Reasoning
If + means - , - means ×, × means ÷ , ÷ means +, then what will come
in place of the question mark (?) in the following equation?
49 - 2 ÷ 5 + 36 × 12 = ?

A.  B. 60

B.  A. 80

C.  D. 100

D.  C. 120

✓

Q94 Reasoning
ST 10 is related to VW -4 in a certain way. In the same way, LM 14 is
related to OP 0. To which of the following is PU 21 related, following
the same logic?

A.  A. KJ 7

B.  C. SX 7

C.  B. JK 8

D.  D. MN 9

✓

Q95 Reasoning
Six people Meenal, Priyam, Reena, Tillu, Vishu and Yogesh are sitting
in a row, facing north. Only two people sit to the right of Reena. Only
two people sit between Reena and Yogesh. Vishu sits third to the left
of Priyam. Priyam does not sit at one of the extreme ends. Tillu is
not an immediate neighbour of Priyam. How many people sit
between Yogesh and Priyam?

A.  D. None

B.  B. One

C.  A. Two

D.  C. Three

✓

Q96 Reasoning
In a certain code language, ‘chat man mop’ is coded as 'ew fj bg' and
‘arch mop voice’ is coded as ‘ee ii fj’. How is ‘mop’ coded in the given
language?

A.  B. fj

B.  D. ew

C.  C. bg

D.  A. ee

✓

Q97 Reasoning
P, Q, R, S, T, U ଓ V ଙ୍କ ମଧ୍ୟରୁ  ପ୍ର ତ୍ୟେକଙ୍କ ପରୀକ୍ଷା ସୋମବାର ଠାରୁ  ଆରମ୍ଭ ହୋଇ
ସେହି  ସପ୍ତାହର ରବି ବାର ଦି ନ ଶେଷ ହେଉଥି ବା ଗୋଟି ଏ ସପ୍ତାହର ଭି ନ୍ନ ଭି ନ୍ନ ଦି ନରେ ଅଛି  ।
ଶନି ବାର ଦି ନ P ଙ୍କ ପରୀକ୍ଷା ଅଛି  । S ଓ V ଙ୍କ ମଧ୍ୟରେ କେବଳ 4 ଜଣ ଲୋକଙ୍କ ପରୀକ୍ଷା
ଅଛି , ସେମାନଙ୍କ ମଧ୍ୟରୁ  କାହାର ସୋମବାର ଦି ନ ପରୀକ୍ଷା ନାହିଁ । T ଙ୍କ ଠି କ ପରେ U ଙ୍କ
ପରୀକ୍ଷା ଅଛି  ଏବଂ T ଙ୍କ ଠି କ ପୂ ର୍ବ ରୁ  Q ଙ୍କ ପରୀକ୍ଷା ଅଛି  । U ଙ୍କ ପରେ V ଙ୍କ ପରୀକ୍ଷା ଅଛି  । P
ଓ T ଙ୍କ ମଧ୍ୟରେ କେତେ ଜଣ ଲୋକଙ୍କ ପରୀକ୍ଷା ଅଛି ?

A.  A. 1

B.  D. 2

C.  C. 3

D.  B. 4

✓

Q98 Reasoning
Based on the alphabetical order, three of the following four are alike
in a certain way and thus form a group. Which is the one that does
not belong to that group?
(Note: The odd man out is not based on the number of
consonants/vowels or their position in the letter-cluster.)2827

A.  D. JGI

B.  A. OKN

C.  C. NJM

D.  B. YUX
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✓

Q99 Reasoning

Read the given statement(s) and conclusions
carefully. Assuming that the information given in
the statements is true, even if it appears to be at
variance with commonly known facts, decide
which of the given conclusions logically follow(s)
from the statement(s).

Statements: All girls are hens. No hen is a cat.

Conclusion (I): No girl is a cat.
Conclusion (II): Some cats are hens.

A.  A. Only conclusion (I) follows

B.  B. Only conclusion (II) follows

C.  C. Neither conclusion (I) nor (II) follows

D.  D. Both conclusions (I) and (II) follow

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । (ଟି ପ୍ପଣୀ: ସମସ୍ତ ସଂଖ୍ୟା କେବଳ ଏକ
ଅଙ୍କ ବି ଶି ଷ୍ଟ ସଂଖ୍ୟା ଅଟେ ।) ଗଣନା କେବଳ ବାମରୁ  ଡାହାଣକୁ  କରାଯି ବ ।
(ବାମ) 3 4 6 7 2 1 3 5 6 8 2 3 5 9 7 1 4 2 6 8 5 3 9 7 4 2 5 (ଡାହାଣ)
ଏପରି  କେତୋଟି  ଯୁ ଗ୍ମ  ଅଙ୍କ ଅଛି , ଯାହାର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ଅଯୁ ଗ୍ମ  ଅଙ୍କ ଏବଂ ଠି କ ପରେ ଏକ
ଯୁ ଗ୍ମ  ଅଙ୍କ ମଧ୍ୟ ଅଛି ?

A.  B. 4

B.  A. 3

C.  D. 5

D.  C. 6
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